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Preface

This guide provides instructions on how to install PDRE Deployment. It walks 
you step-by-step through each install phase and provides you with 
information about what to do next.

Before you install, be sure to read the Release Notes. Release Notes provide 
important information about the latest version.

After you install the software, you are required to perform additional steps 
to prepare your database for activation and replication. This information is 
described in the PeerDirect Replication Engine Getting Started Guide. 

For more information about deployment and advanced features, such as 
fragments and work sets, refer to the PeerDirect Replication Engine 
Developer’s Guide. 

Who is This Guide For
This guide is intended for anyone who is responsible for setting up and 
maintaining a PeerDirect Replication Network. This person might also be 
responsible for administering the network’s software components, including 
PeerDirect replication servers and adapters, databases, and ODBC drivers. 
In this guide this role is referred to as the PeerDirect administrator.

A PeerDirect administrator should already be a certified database 
administrator for the databases they are replicating. The PeerDirect 
documentation is specific to PeerDirect products and only offers guidelines 
for integrating third-party vendor and Open Source databases, as part of a 
PeerDirect Replication Network.
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What is in This Guide
This guide contains the following chapters:

• “Welcome to PDRE Deployment,” on page 9.

Provides a general introduction to the installation process and describes 
options for configuring your Replication Network.

• “Installing PDRE Deployment,” on page 23.

Outlines the steps for installing the Replication Engine.

Notation Conventions
This guide uses the following notation conventions:

• The notation Menu>Choice indicates that you should select an item 
from a menu. For example, the notation File>Exit means "From the 
File menu select Exit."

• Italic text indicates the title of a book or emphasizes the first usage of 
a term that is repeated in the guide.

• Monospace text indicates commands, functions, code examples, and 
names of files and directories. For example:

C:\Program Files\PeerDirect\setup.exe

• Monospace italic text indicates that a term can be replaced by a 
literal value. Typically the term is enclosed in brackets (< >) and used 
in example text, such as command lines or directory paths. The user is 
expected to replace the term with an appropriate value. For example:

<drive>:\<install_dir>\setup.exe

where <drive> can be replaced by the drive name "C" and 
<install_dir> can be replaced by the installation directory name 
"Program Files\PeerDirect."
vi



Preface
Additional References
The following Replication Network documentation is available:

Replication Engine Getting Started Guide

A guide that provides details on planning, designing, and preparing to 
implement a PeerDirect Replication Network.

Replication Engine Designer’s Guide

A guide that provides details on defining replication rules.

Replication Engine Administrator’s Guide

A guide that provides details on activating and maintaining a Replication 
Network.

Replication Engine SDK Installation Guide

A guide that describes the procedure for installing the PeerDirect Replication 
Engine SDK software. It also describes how to define replication rules and 
set up replication sites in a PeerDirect SDK environment.

PDRE Deployment Installation Guide

A guide that describes the procedure for installing the PDRE Deployment 
software. 

How to View This Guide Online
Online versions of this guide are available in Adobe™ Acrobat™ (PDF) 
format on the PeerDirect Distributed Enterprise Software Development Kit 
CD-ROM. All PeerDirect product documentation is located in the 
%PDRE%\pdre\docs directory.
vii



Customer Support
If you encounter a technical problem, and are covered by a PeerDirect 
Customer Support agreement, send e-mail to our support team at 
support@peerdirect.com.

The PeerDirect Customer Support team is dedicated to providing rapid, 
high-quality response to customer problems. When contacting Customer 
Support, please provide the following information:

• Case number (if you are calling about a previous problem).

• Your name.

• Your company name and location (city, state or province, and country).

• Contact information.

• Product name and version.

• Operating system.

• Database type.

• Detailed problem description that includes specific symptoms, 
observations and any troubleshooting steps you might have tried.

• Attach activity (.log) log file(s) for the component(s) that you are 
having problems with.



1
Welcome to PDRE Deployment

This chapter introduces you to PDRE Deployment and consists of the 
following information:

• Overview, on page 10.

• Supported Platforms, on page 12.

• Supported Databases, on page 13.

• Product Licenses, on page 14.

• About the Install Program, on page 14.

• Deployment Options, on page 17.

• Selecting a Network Topology, on page 19.

• How to Design a Replication Network, on page 21.

• What is Next, on page 22.
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Overview 
PDRE Deployment provides a production environment for a Replication 
Network. PDRE Deployment installs everything you need to run the 
Replication Engine. 

A Replication Network is a configuration of Complete, High Availability, and 
Low Availability sites. Each site can be either one of the following:

• A computer with its own local database

• A shared database

On each site, a copy of the database runs locally and therefore, is always 
available. In the background, the PeerDirect Replication Engine manages 
changes to your database by replicating and synchronizing data updates 
with other active sites on the network. 

The following figure shows a replication network that consists of two 
Complete sites (home office) connected over a TCP/IP network to several 
High Availability and Low Availability sites set up in remote field or office 
locations.

Figure 1–1 shows an example of a Replication Network.
10



Welcome to PDRE Deployment
Figure 1–1: PeerDirect Replication Network

You can set up a PeerDirect Replication Network in several different ways, 
but for greatest benefit, it is recommended you select one that matches the 
business requirements for distributing application data within your system. 
Each Replication Network manages the database for one or more 
applications (or unrelated database tables) that you want to connect across 
your organization. There is no limit to the number of Replication Networks 
you can set up. 

For more information about laying out a Replication Network, refer to the 
PeerDirect Replication Engine Getting Started Guide

For assistance in planning your PeerDirect Replication Network, contact your 
PeerDirect account manager or send e-mail to PeerDirect Technical Support 
at support@peerdirect.com.
11
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Supported Platforms
PDRE Deployment supports the following platforms:

• AIX, version 5.2 or higher

• Red Hat Linux, version 9.0

• Red Hat Enterprise Linux version 3.0

• SUSE Linux, version 8.2 or higher

• Windows 2000 Server or Workstation, Service Pack 4 or higher

• Windows 2003 Server

• Windows XP

Hardware
Pentium-based computer with a minimum of 64 MB1 of memory, and a 

minimum of 100 MB2 of disk space.

NOTE: 1. 128 MB of memory is recommended.
2. Minimum physical memory should be at least two times the size 
of the largest individual record to be replicated. For example, if 
your database has a single record containing 50 MB of data, then a 
minimum of 100 MB of disk space is required to avoid performance 
degradation.
12
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Supported Databases
The Data Replication Engine, supports the following databases:

• IBM DB2 Universal Database 7.2 and 8.1

• Microsoft Data Engine (MSDE) 2000

• Microsoft SQL Server 2000

• Oracle 8.1.6, 8.1.7, and Oracle 9i

For more information regarding each database supported by the Distributed 
Enterprise environment, refer to the PeerDirect Replication Engine Getting 
Started Guide.

Supported ODBC Drivers and Replication Adapters
The following ODBC drivers and replication adapters have been certified for 
use with PDRE Deployment.

Table 1–1: PeerDirect-Supported Drivers and Adapters

NOTE: Some ODBC drivers do not meet the requirements of the 
Replication Engine and could cause problems, if they are used.

Database Supported Drivers and Adapters

IBM DB2 Universal 
Database 7.2 and 8.1

Peer Direct DB2

MSDE and Microsoft SQL 
Server 2000

Peer Direct SQL Server

Oracle 8i and 9i Peer Direct Oracle, Peer Direct Oracle8
13
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Product Licenses
There are two types of PeerDirect license files — PeerDirect Network License 
(PNL) and PeerDirect Developer License (PDL). 

The PeerDirect Network License (PNL) enables you to activate a 
vendor-specific database and replicate data with other databases in a 
Replication Network. You must obtain database software separately and 
install it according to vendor instructions, before you install PDRE 
Deployment.

The PeerDirect Developer License (PDL) lets you enable any database type 
for replication, but it does not let you deploy a Replication Network. The 
Developer License lets you define rules for a database, as for example a 
Microsoft SQL Server database, but you would then need a Microsoft SQL 
Server Replication Network License before you could activate the sites and 
deploy the Replication Network.

PeerDirect product licenses are distributed by PeerDirect Technical Support. 
If you need assistance, please contact them at support@peerdirect.com.

About the Install Program
The PDRE Deployment install program uses a Web-based installation 
program. The Install Program is easy-to-use and leads you through each 
phase of the installation process.

PDRE Deployment includes all components listed in Installation 
Components, on page 14. The install program installs these components 
into the specified installation directory. To install PDRE Deployment, see 
“Installing PDRE Deployment,” on page 23.

Installation Components
PeerDirect is a software system for replicating and synchronizing data 
stored in databases. It supports asynchronous, bidirectional database 
replication across TCP/IP networks and replicates structured data between 
both homogeneous and heterogeneous database types. 
14
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PDRE Deployment installs the following components:

After you install PDRE Deployment, you can use the Administrator to define 
replication schedules, subscribe to work set slices, and change site 
information.

NOTE: If you are installing on Linux, you will need to install the PDRE 
Deployment on a Windows system and use the dinstc utility to 
establish the connection from the Windows system to the 
Replication Engine running on the Linux system. This enables the 
Administrator to connect to the Replication Engine on a Linux 
system and administer the specified database in the Replication 
Network.

Components Description

Replication Engine Core replication component. The 
Replication Engine detects changes 
made to databases since the last 
replication session, and propagates 
these changes to other 
replication-enabled sites on the 
Replication Network. It performs all 
replication tasks including database 
updates, inserts, and deletions.

Administrator

(Windows only)

Administers replication schedules 
and subscribes work set slices.

Replication Engine 
User Interface"

Initiates and monitors data 
replication sessions.

Replication Engine 
Utilities

Performs various administration and 
configuration tasks, including 
enabling of the database activation 
process. 

Database ODBC 
Drivers and 
Replication Adapters

PeerDirect ODBC drivers and 
replication adapters for your 
database.
15
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Installation Options
The PeerDirect installation program gives you two installation options. 

• Quick Installation — installs the Replication Engine components to 
the specified installation directory. On Linux, you must also specify a 
user name or account that will own the Replication Engine daemon.

Select this method for an easy installation. This option lets you select 
the directory where you want PeerDirect software installed and 
automatically configures the installation using the default settings for 
the PDRE Runtime edition.

• Custom Installation — installs only components you select. For 
certain components, you may also select server ports, server start-up 
preferences, and other settings. The install program also lets you add 
new software components to the installation. 

Select this method if you want to change the default component 
settings or to install a subset of the components available. For the 
Replication Engine, you must select one of two editions:

– Runtime Edition — installs the Replication Engine and 
Administrator. This is the standard PDRE Deployment installation.

– Client Access Edition — installs the Administrator and APIs, but 
does not install the Replication Engine. Select this edition when you 
are running PeerDirect replication servers on Linux and need to use 
the Administrator. 
16
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Deployment Options
A Replication Network can be deployed in several different ways. You should 
select the one that closely matches the way in which you want to distribute 
the database’s data. 

This section outlines the following ways:

• Replication Engine and Multiple Databases on Same Computer, on page 
17.

• Replication Engine and Single Database on Same Computer, on page 
18.

• Replication Engine and Database on Different Computers, on page 18.

Replication Engine and Multiple Databases on Same Computer
In this scenario, each computer within the network has 2 or more databases 
and the PeerDirect Replication Engine installed. This type of deployment is 
useful in a testing or non-production environment. 

This scenario, mimics a typical development environment.

Figure 1–2: Replication Engine and Multiple Databases on Same Computer
17



Replication Engine and Single Database on Same Computer
In this scenario, each computer within the network has a single database 
and the PeerDirect Replication Engine installed. One computer is activated 
as the First Site while additional computers are activated as High 
Availability, or Low Availability sites. The First Site contains all of the data 
that comprises a Replication Network, while the High Availability or Low 
Availability sites only contain that data that is of interest to its users.

This scenario mimics a typical wide area network deployment, in which two 
sites exist in separate local area networks.

Figure 1–3: Replication Engine and Single Database on Same Computer

Replication Engine and Database on Different Computers
In this scenario, computers within the network have a single database 
installed, and a different computer has a single copy of the Replication 
Engine installed. The single instance of the Replication Engine interacts with 
all of the databases on the network.

This scenario is best suited for local area network deployment.

Figure 1–4: Replication Engine and Database on Different Computers
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Selecting a Network Topology
The way in which data is replicated within a Replication Network is 
dependent on the types of sites that comprise a Replication Network. The 
following types of sites can be defined within a Replication Network:

• Complete
Used to specify computers that will always be available for replication 
and contain a complete copy of the database. 

• High Availability
Used to specify computers that are always available for replication, but 
contain a subset of the database. For example, servers or workstations 
that are always connected to the network.

• Low Availability
Used to specify computers that are not always available for replication 
and contain a subset of the database. For example, servers or 
workstations that use a dial-up connection to connect to the network. 

NOTE: Low availability sites only replicate with high availability or 
complete sites when the replication session is initiated by the 
low availability site.
19
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Hub and Spoke Topology
In this scenario, there is a single high availability or complete site and 
multiple low availability sites. Replication sessions can only be initiated by 
the low availability sites.

This topology is suitable for providing replication support for mobile users 
who do not have a fixed IP address.

Peer to Peer Topology
In this scenario, each of the sites that comprise the Replication Network are 
high availability or complete sites. Replication sessions can be initiated by 
any site on the network.

This topology is suitable for providing replication support for sites that have 
fixed IP addresses.
20
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Multi-Tier Topology
In this scenario, there is a combination of high availability or complete sites 
and low availability sites. The high availability or complete sites can initiate 
replication sessions with each other, and low availability sites can initiate 
replication sessions with any high availability or complete site.

This topology is suitable for providing replication support for both sites that 
have fixed IP addresses and sites that do not have fixed IP addresses.

How to Design a Replication Network
To design a Replication Network, perform the following:

1. Install the PeerDirect Distributed Enterprise Software Development Kit.
For more information, refer to the PeerDirect Replication Engine SDK 
Installation Guide.

2. Prepare the database(s) for replication.
For more information, refer to the PeerDirect Replication Engine Getting 
Started Guide.

3. Create a data replication plan.
For more information, refer to the PeerDirect Replication Engine Getting 
Started Guide.

4. Define database replication rules.
For more information, refer to the PeerDirect Replication Engine 
Designer’s Guide.
21
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5. Install and configure the sites that comprise the Replication Network.
For more information, refer to the PDRE Deployment Installation Guide.

6. Activate the First Site and secondary sites, using pdactivate.
For more information, refer to the PeerDirect Replication Engine 
Administrator’s Guide.

What is Next
In the next chapter you will find information about installing PDRE 
Deploymen. For more information about setting up your Replication 
Network, refer to the PeerDirect Replication Engine Getting Started Guide.
22
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Installing PDRE Deployment 

This chapter describes how to install PDRE Deployment. It includes the 
following sections:

• Planning Your Install, on page 24.

• Before You Install, on page 24.

• Installing PDRE Deployment, on page 25.

• Updating a PDRE Deployment Installation, on page 33.

• Uninstalling PDRE Deployment, on page 42.

• What is Next, on page 42.
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Planning Your Install
Deploying a Replication Network requires that you install the PDRE 
Deployment on multiple sites within the Replication Network to enable each 
of the sites to run the Replication Engine. This is required whether you are 
installing a two-server failover system, a development or test environment, 
or a large network of application servers. 

Because a PeerDirect Replication Network is made up of individual 
replication sites that have different requirements based on their position in 
the network, the first step to planning your installation is to identify the 
replication requirements for the system you are installing.

The installation instructions in this guide describe how to install PDRE 
Deployment. For information about designing your Replication Network, 
refer to the PeerDirect Replication Engine Getting Started Guide.

Before You Install
Before you begin the installation process, perform the following:

1. Verify that you have received the correct PeerDirect software license 
from PeerDirect Technical Support.There are several types of licenses 
available from PeerDirect based on the replication server type and 
vendor-branded database you are deploying. Please refer to Table 1–1, 
on page 13 for a list of supported databases.

2. Review the PeerDirect system requirements in “Supported Platforms,” 
on page 12 and verify that the system you plan to use meets these 
requirements.

3. Read the Release Notes, for information about the latest release.

4. Verify that your system hardware and software meet the requirements 
for the type of PeerDirect Replication Network you have planned. You 
will find the requirements for PeerDirect replication servers and 
workstations in “Supported Platforms,” on page 12.

5. If you are planning to replicate an existing database, it is recommended 
that you back up your current database before you install PDRE 
Deployment.
24
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6. On Linux, if you want more than one person to be able to run the 
Replication Engine, specify a user name or account to own it and place 
that user in a group to which you can add other users.

7. On Linux, you must install as root user. On Windows, you must have 
administrator privileges to install.

8. On Red Hat Enterprise Linux version 3.0, you must first install the 
Legacy Software Development component. If you are using runlevel 5, 
select System Settings>Add/Remove Applications> 
Development>Legacy Software Development

9. On Red Hat Linux 9.0 you must first install 
compat-libstdc++-7.3-2.96.118.i386.rpm. This file is located on Disk 1 
of the Red Hat Linux 9.0 CDs.

The PeerDirect license that you are issued from PeerDirect Technical 
Support provides you with the appropriate permissions to install the 
replication adapter or ODBC driver for your selected database type. 

If you have any questions about your license, contact PeerDirect Technical 
Support at support@peerdirect.com.

Installing PDRE Deployment
This section describes how to install PDRE Deployment. 

Follow these instructions if you are installing PDRE Deployment for the first 
time. If you are performing a follow-up installation or upgrading your 
current installation, see “Updating a PDRE Deployment Installation,” on 
page 33.

NOTE: The Windows version of the Replication Engine has a dll called 
libeay32.dll. In order for the Replication Engine to function this 
dll must be first in the environment path.
25
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To install PDRE Deployment:

1. Follow instructions below for your platform:

• Linux — Log on as a root user. Run ./setup from the directory 
where you extracted the PDRE tar file. 

• Windows — Log on to a Windows server or workstation as 
Administrator. Run setup.exe from the directory where you 
extracted the PDRE zip file.

The Welcome to PeerDirect Software Installation screen displays. 

2. Click Start Installation.
26
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3. In the Specify the installation location field, enter the full 
directory path for the installation directory. The install program will 
install the PDRE Deployment software in this directory.You can accept 
the default, type a new path, or click Browse to specify an existing 
directory.

The default installation directory paths are

4. Click Continue.
The License Agreement page appears.

Platform Run As... Destination

Red Hat Linux ROOT /usr/local/peerdirect

Microsoft 
Windows

ADMIN 
PRIVS

C:\Program 
Files\PeerDirect
27
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5. Read the PeerDirect license agreement carefully.

• If you agree to the license, scroll to the bottom of the page and click 
Accept to continue with the installation.
The Installation Method page appears.

• If you do not agree to the license, scroll to the bottom of the page 
and click Decline to exit the Installation program.
28
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6. Select one of the following installation methods:

• Quick Installation — installs all of the Replication Engine 
components, using the Runtime edition default settings.

• Custom Installation — Enables you to select the components you 
want to install and enables you to change component settings.

7. If you selected Quick Installation, click Continue.
If you selected Custom Installation, continue with Step 9.

8. Verify the components that will be installed and do the following:

a) On Linux, in the Specify the component account field, enter a 
user name. The user name or account you specify will be able to 
run the daemons for installed components after the installation 
completes. 

b) Click Install and go to Step 11.
29
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9. On Windows, specify which edition of the PDRE Deployment that you 
want to install by clicking the appropriate radio button:

• Runtime edition — Installs all of the Replication Engine software 
components and utilities. This is the standard PDRE Deployment 
installation.

• Client Access edition — Only installs the Administrator user 
interface. Select this edition if you are running PeerDirect 
replication servers on Linux and need to use the Administrator 
interface to administer it from a Windows computer. In the 
Client’s Replication Server field, enter the network name of 
the server to be administered. 

NOTE: If you have previously installed PDRE Deployment, the install 
program recognizes the previous installation and provides you 
with the option to update it. For more information, see “Updating 
a PDRE Deployment Installation,” on page 33.

On Linux, 

• In the User Name field enter the network name of the server to be 
administered. 

• Check Create New User if you want the user name or account 
created and added to your system. 
30
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10. Click Install.
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11. The install program lists each installed component and shows you the 
progress of the installation.

12. When the install program completes, close the browser window.
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Updating a PDRE Deployment Installation
From time to time, you might want to update your PDRE Deployment 
installation by installing additional components or upgrading the Replication 
Engine. To update a PDRE Deployment installation, run the latest install 
program and specify the location of your existing Replication Engine 
installation directory. The PDRE Deployment install program recognizes the 
Replication Engine components you have installed and will update your site 
using new components you select. 

NOTE: The Windows version of the Replication Engine as a dll called 
libeay32.dll. In order for the Replication Engine to function this dll 
must be first in the environment path.

Read the Release Notes before you perform an upgrade.

To update a PDRE Deployment installation

1. Follow instructions below for your platform:

• Linux — Log on as a root user. Run ./setup from the directory 
where you extracted the PDRE tar file. 

• Windows — Log on to a Windows server or client computer. Run 
setup.exe from the directory where you extracted the PDRE zip 
file.

The Welcome to PeerDirect Software Installation screen displays. 
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2. Click Start Installation.

3. Read the PeerDirect license agreement carefully.

• If you agree to the license, scroll to the bottom of the page and click 
Accept to continue with the installation.
The Configure the following Components page appears.

• If you do not agree to the license, scroll to the bottom of the page 
and click Decline to exit the Installation program.
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4. The install program recognizes that PDRE Deployment is installed and 
indicates that the Replication Engine will be upgraded.
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5. Specify the edition of PDRE Deployment you want to upgrade, by 
clicking the appropriate radio button:

• Runtime edition — Installs all of the Replication Engine 
software components and utilities. This is the standard PDRE 
Deployment installation.

• Client Access edition — Only installs the Administrator user 
interface. Select this edition if you are running the Replication 
Engine on Linux and want to use the Administrator interface 
from a Windows computer. In the Client’s Replication 
Server field, enter the network name of the server to be 
administered. 
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6. Click Install.
The install program shows you the progress of the installation.

7. When the installation is complete, close the browser window.

8. To include the new 7.4 features, upgrade your replication rules. For 
more information, see “Upgrading Replication Rules to 7.4,” on page 
39.
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Upgrading Replication Rules to 7.4
Replication Engine version 7.4 and later includes some new Replication 
Engine system tables. These tables must be added to your database in order 
to use the new Horizon and Scheduling features. To do this you will need to 
upgrade your replication rules.

To upgrade the replication rules to include the new 7.4 features:

Before upgrading your rules:

1. Backup the databases at each of the sites.

2. If you do not have a development database associated with your SDK, 
then you can create one by dumping the schema out of a production 
database. To do this, perform the following:

a) Restore a database in your development environment, using a 
backup copy from a production or live database.

NOTE: Make sure you include any Replication Engine system and 
control tables.

b) Mark the database as inactive by running the following SQL 
statement:
update dcnf set CnfValue=’a0a’, Stamp=NULL where 
CnfName=’PDS_STATE’
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In your development environment:

3. Upgrade your rules to include the new Replication Engine system tables. 
You can do this using either Replication Designer or prdc 
EXPORTSCRIPT.

Upgrading Rules using Replication Designer

To create the new Replication Engine system tables using Replication 
Designer:

a) Launch Replication Designer.

b) From the Database Wizard window, select the name of your 
development database.

c) Click Finish.
The PeerDirect Development Studio window appears.

d) Save the files that Replication Designer created. 
To do this, select File>Save. 

e) Verify the replication rules. 
To do this, select Tools>Verify Rules. 

f) Prepare the rules for activation. 
To do this, select Tools>Prepare to Activate.

g) Export the replication rules. 
To do this, select File>Export Rules.

Upgrading Rules using prdc

To create the new Replication Engine system tables using prdc, use the 
following command:

prdc PREPARE -odbcn=<odbcuser> -odbcp=<odbcpassword> 
-da=<dbtype> -db=<connstr> -RuleFile=<rule> -ExportRules

For more information, refer to the Replication Engine Designer’s Guide.
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4. Upgrade the replication rules on all sites within the development 
environment, using pdupgrade. For example:
pdupgrade PDABCDEF00n xPD000EG.rul

For the First Site, ensure you include -FIRSTSITE. For example:
pdupgrade PDABCDEF00n xPD000EG.rul -FIRSTSITE

For more information, refer to the Replication Engine Administrator’s 
Guide.

5. Test replication within your development environment and repeat steps 
4 and 5 as required.

In your production environment:

6. Upgrade the replication rules on all sites within the production 
environment, using pdupgrade. For example:
pdupgrade PDABCDEF00n xPD000EG.rul

For the First Site, ensure you include -FIRSTSITE. For example:
pdupgrade PDABCDEF00n xPD000EG.rul -FIRSTSITE

For more information, refer to the Replication Engine Administrator’s Guide.
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Uninstalling PDRE Deployment
To uninstall PDRE Deployment:

1. On Windows, select Start>PeerDirect>Uninstall PDRE.

On Linux, log in as root and use the script <install_dir>/uninstall

where <install_dir> is the directory path for your PeerDirect installed 
components.

The Uninstall PDRE window appears.

2. In the Enter Choice field, enter 2 to uninstall PDRE Deployment.

3. Click Enter.
PDRE Deployment is uninstalled.

What is Next
You have successfully installed the PDRE Deployment and are now ready to 
begin the configuration and set-up work described in the PeerDirect Getting 
Started Guide.
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